
Re: Windows Update after SP2 installation

Source:
http://www.tech−archive.net/Archive/Windows/microsoft.public.windowsupdate/2005−07/msg00679.html

From: "Patti MacLeod" <pam120@xxxxxxxxxxxxx>• 
Date: Fri, 8 Jul 2005 13:08:14 −0400• 

I did some searching of the error #0x80040154 and the most common cause is
the MSXML3.dll file being not properly registered. To re−register it.......

Start>Run and key in:
regsvr32 MSXML3.dll
Click on OK or hit ENTER
Click on OK in the RegSvr32 dialogue box

Unfortunately, that is one of the dll registration entries that was in my
first response, so you should have already performed the re−registration to
no avail.

The only other thing that I can think of, at the moment, for you to try is
to d/load and install Microsoft XML Parser (MSXML) 3.0 Service Pack 5 (SP5):
http://www.microsoft.com/downloads/details.aspx?FamilyID=4a3ad088−a893−4f0b−a932−5e024e74519f&DisplayLang=en

Regards,

−−
Patti MacLeod
Microsoft MVP − Windows Shell/User

"jalbert" <jalbert@xxxxxxxxxxxxxxxxxxxxxxxxx> wrote in message
news:BC4E3495−FD6E−48CF−BFD7−D130C9206126@xxxxxxxxxxxxxxxx
> Patti − Here is the log file contents. Looks like there were 5 updates
> found, but there is a recurring fatal event. Thanks.
>
> 2005−07−07 06:20:26 1148 7cc AU ## START ## AU: Search for updates
> 2005−07−07 06:20:26 1148 7cc AU #########
> 2005−07−07 06:20:26 1148 7cc AU <<## SUBMITTED ## AU: Search for updates
> [CallId = {0DD88C16−797C−42BA−9B20−C18EBA75F481}]
> 2005−07−07 06:20:26 1148 670 Agent *************
> 2005−07−07 06:20:26 1148 670 Agent ** START ** Agent: Finding updates
> [CallerId = AutomaticUpdates]
> 2005−07−07 06:20:26 1148 670 Agent *********
> 2005−07−07 06:20:55 1148 670 Setup *********** Setup: Checking whether
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> self−update is required ***********
> 2005−07−07 06:20:55 1148 670 Setup * Inf file:
> C:\WINDOWS\SoftwareDistribution\SelfUpdate\Default\wusetup.inf
> 2005−07−07 06:20:55 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\cdm.dll: target version = 5.8.0.2469, required version
=
> 5.8.0.2469
> 2005−07−07 06:20:55 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\iuengine.dll: target version = 5.8.0.2469, required
> version = 5.8.0.2469
> 2005−07−07 06:20:55 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wuapi.dll: target version = 5.8.0.2469, required
version
> = 5.8.0.2469
> 2005−07−07 06:20:55 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wuauclt.exe: target version = 5.8.0.2469, required
> version = 5.8.0.2469
> 2005−07−07 06:20:56 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wuauclt1.exe: target version = 5.8.0.2469, required
> version = 5.8.0.2469
> 2005−07−07 06:20:56 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wuaucpl.cpl: target version = 5.8.0.2469, required
> version = 5.8.0.2469
> 2005−07−07 06:20:56 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wuaueng.dll: target version = 5.8.0.2469, required
> version = 5.8.0.2469
> 2005−07−07 06:20:56 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wuaueng1.dll: target version = 5.8.0.2469, required
> version = 5.8.0.2469
> 2005−07−07 06:20:57 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wucltui.dll: target version = 5.8.0.2469, required
> version = 5.8.0.2469
> 2005−07−07 06:20:57 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wups.dll: target version = 5.8.0.2469, required
version =
> 5.8.0.2469
> 2005−07−07 06:20:57 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wups2.dll: target version = 5.8.0.2469, required
version
> = 5.8.0.2469
> 2005−07−07 06:20:57 1148 670 Setup Update NOT required for
> C:\WINDOWS\system32\wuweb.dll: target version = 5.8.0.2469, required
version
> = 5.8.0.2469
> 2005−07−07 06:20:57 1148 670 Setup * IsUpdateRequired = No
> 2005−07−07 06:21:34 1148 670 PT +++++++++++ PT: Synchronizing server
> updates +++++++++++
> 2005−07−07 06:21:34 1148 670 PT + ServiceId =
> {9482F4B4−E343−43B6−B170−9A65BC822C77}, Server URL =
> https://update.microsoft.com/v6/ClientWebService/client.asmx
> 2005−07−07 06:21:37 1148 670 Agent WARNING: Failed to evaluate Installed
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> rule, updateId = {ED300F67−421C−4C08−B3BA−F35C55F3B427}.100, error =
> 0x80040154
> 2005−07−07 06:21:40 1148 670 Agent WARNING: Failed to evaluate Installed
> rule, updateId = {794F5418−EDF1−44D6−97F4−8D693BC4CD97}.17, error =
0x80040154
> 2005−07−07 06:21:41 1148 670 Agent WARNING: Failed to evaluate Installed
> rule, updateId = {02FF0A91−FC2F−4218−AAF5−D28FDD327581}.101, error =
> 0x80040154
> 2005−07−07 06:21:55 1148 670 PT +++++++++++ PT: Synchronizing extended
> update info +++++++++++
> 2005−07−07 06:21:55 1148 670 PT + ServiceId =
> {9482F4B4−E343−43B6−B170−9A65BC822C77}, Server URL =
> https://update.microsoft.com/v6/ClientWebService/client.asmx
> 2005−07−07 06:21:57 1148 670 Agent * Added update
> {E5F21832−ED23−4339−BA4C−F63089DD1AE8}.103 to search result
> 2005−07−07 06:21:57 1148 670 Agent Update
> {F40BE46A−2611−47F5−B570−FBE4E8690AFC}.103 is pruned out due to potential
> supersedence
> 2005−07−07 06:21:57 1148 670 Agent * Added update
> {6917A042−BA50−4723−A0C3−3783A8DDC28B}.10 to search result
> 2005−07−07 06:21:57 1148 670 Agent * Added update
> {BB758AAA−8024−44D0−8434−73CEFE8CA80B}.10 to search result
> 2005−07−07 06:21:57 1148 670 Agent Update
> {4E57D979−58B2−4D06−8233−689BA4F10116}.10 is pruned out due to potential
> supersedence
> 2005−07−07 06:21:57 1148 670 Agent * Added update
> {1FD3B3AC−9E83−4286−8369−D122669C24F6}.11 to search result
> 2005−07−07 06:21:57 1148 670 Agent Update
> {A2D28A3A−34AD−4044−A890−3231305FCF5F}.50 is pruned out due to potential
> supersedence
> 2005−07−07 06:21:57 1148 670 Agent * Added update
> {674807A6−9965−47C5−997A−E29CC6B5F7B8}.100 to search result
> 2005−07−07 06:21:57 1148 670 Agent * Found 5 updates and 10 categories
in
> search
> 2005−07−07 06:21:57 1148 670 Report *********** Report: Initializing
static
> reporting data ***********
> 2005−07−07 06:21:57 1148 670 Report * OS Version = 5.1.2600.2.0.65792
> 2005−07−07 06:21:57 1148 670 Report WARNING: Failed to load reporting
> information from Win32_ComputerSystem with hr = 80040154.
> 2005−07−07 06:21:57 1148 670 Report WARNING: Failed to load reporting
> information from Win32_BiosProperties with hr = 80040154.
> 2005−07−07 06:21:57 1148 670 Report * Locale ID = 1033
> 2005−07−07 06:21:57 1148 670 Agent *********
> 2005−07−07 06:21:57 1148 670 Agent ** END ** Agent: Finding updates
> [CallerId = AutomaticUpdates]
> 2005−07−07 06:21:57 1148 670 Agent *************
> 2005−07−07 06:21:57 1148 670 AU >>## RESUMED ## AU: Search for updates
> [CallId = {0DD88C16−797C−42BA−9B20−C18EBA75F481}]
> 2005−07−07 06:21:57 1148 670 AU # 5 updates detected
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> 2005−07−07 06:21:57 1148 670 AU #########
> 2005−07−07 06:21:57 1148 670 AU ## END ## AU: Search for updates
[CallId
> = {0DD88C16−797C−42BA−9B20−C18EBA75F481}]
> 2005−07−07 06:21:57 1148 670 AU #############
> 2005−07−07 06:21:57 1148 670 AU AU setting next detection timeout to
> 2005−07−08 06:26:27
> 2005−07−07 06:21:57 1148 670 AU AU setting pending client directive to
> 'Download Approval'
> 2005−07−07 06:22:02 1148 670 Report REPORT EVENT:
> {5CC04F75−1984−41B8−87CD−99777ED90D22} 2005−07−07
> 06:21:57−0400 1 147 101 {00000000−0000−0000−0000−000000000000} 0 0
AutomaticUpdates Success Software Synchronization Agent has finished
detecting items.
> 2005−07−07 06:22:11 1148 7cc AU AU found 1 sessions to launch client into
> 2005−07−07 06:22:11 1148 7cc AU Launched new AU client for directive
> 'Download Approval', session id = 0x0
> 2005−07−07 06:22:12 3512 dbc Misc =========== Logging initialized (build:
> 5.8.0.2469, tz: −0400) ===========
> 2005−07−07 06:22:12 3512 dbc Misc = Process:
C:\WINDOWS\system32\wuauclt.exe
> 2005−07−07 06:22:12 3512 dbc AUClnt Launched Client UI process
> 2005−07−07 06:22:18 3512 dbc AUClnt FATAL: Failed to get agent interface
> pointers, hr=80040154
> 2005−07−07 06:22:18 1148 7cc AU AU setting pending client directive to
> 'Download Approval'
> 2005−07−07 06:22:32 1148 7cc AU AU found 1 sessions to launch client into
> 2005−07−07 06:22:32 1148 7cc AU Launched new AU client for directive
> 'Download Approval', session id = 0x0
> 2005−07−07 06:22:32 3692 e70 Misc =========== Logging initialized (build:
> 5.8.0.2469, tz: −0400) ===========
> 2005−07−07 06:22:32 3692 e70 Misc = Process:
C:\WINDOWS\system32\wuauclt.exe
> 2005−07−07 06:22:32 3692 e70 AUClnt Launched Client UI process
> 2005−07−07 06:22:38 3692 e70 AUClnt FATAL: Failed to get agent interface
> pointers, hr=80040154
> 2005−07−07 06:22:38 1148 7cc AU AU setting pending client directive to
> 'Download Approval'
> 2005−07−07 06:22:52 1148 7cc AU AU found 1 sessions to launch client into
> 2005−07−07 06:22:52 1148 7cc AU Launched new AU client for directive
> 'Download Approval', session id = 0x0
> 2005−07−07 06:22:52 3848 f0c Misc =========== Logging initialized (build:
> 5.8.0.2469, tz: −0400) ===========
> 2005−07−07 06:22:52 3848 f0c Misc = Process:
C:\WINDOWS\system32\wuauclt.exe
> 2005−07−07 06:22:52 3848 f0c AUClnt Launched Client UI process
> 2005−07−07 06:22:58 3848 f0c AUClnt FATAL: Failed to get agent interface
> pointers, hr=80040154
> 2005−07−07 06:22:58 1148 7cc AU AU setting pending client directive to
> 'Download Approval'
> 2005−07−07 06:23:12 1148 7cc AU AU found 1 sessions to launch client into
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> 2005−07−07 06:23:12 1148 7cc AU Launched new AU client for directive
> 'Download Approval', session id = 0x0
> 2005−07−07 06:23:12 3924 f58 Misc =========== Logging initialized (build:
> 5.8.0.2469, tz: −0400) ===========
> 2005−07−07 06:23:12 3924 f58 Misc = Process:
C:\WINDOWS\system32\wuauclt.exe
> 2005−07−07 06:23:12 3924 f58 AUClnt Launched Client UI process
> 2005−07−07 06:23:18 3924 f58 AUClnt FATAL: Failed to get agent interface
> pointers, hr=80040154
> 2005−07−07 06:23:18 1148 7cc AU AU setting pending client directive to
> 'Download Approval'
> 2005−07−07 06:23:32 1148 7cc AU AU found 1 sessions to launch client into
> 2005−07−07 06:23:32 1148 7cc AU Launched new AU client for directive
> 'Download Approval', session id = 0x0
> 2005−07−07 06:23:33 4040 fcc Misc =========== Logging initialized (build:
> 5.8.0.2469, tz: −0400) ===========
> 2005−07−07 06:23:33 4040 fcc Misc = Process:
C:\WINDOWS\system32\wuauclt.exe
> 2005−07−07 06:23:33 4040 fcc AUClnt Launched Client UI process
> 2005−07−07 06:23:39 4040 fcc AUClnt FATAL: Failed to get agent interface
> pointers, hr=80040154
> 2005−07−07 06:23:39 1148 7cc AU AU setting pending client directive to
> 'Download Approval'
> 2005−07−07 06:23:53 1148 7cc AU AU found 1 sessions to launch client into
> 2005−07−07 06:23:53 1148 7cc AU Launched new AU client for directive
> 'Download Approval', session id = 0x0
> 2005−07−07 06:23:53 4084 ff8 Misc =========== Logging initialized (build:
> 5.8.0.2469, tz: −0400) ===========
> 2005−07−07 06:23:53 4084 ff8 Misc = Process:
C:\WINDOWS\system32\wuauclt.exe
> 2005−07−07 06:23:53 4084 ff8 AUClnt Launched Client UI process
> 2005−07−07 06:23:59 4084 ff8 AUClnt FATAL: Failed to get agent interface
> pointers, hr=80040154
> 2005−07−07 06:23:59 1148 7cc AU AU setting pending client directive to
> 'Download Approval'
>
>
>
> "Patti MacLeod" wrote:
>
> > Perhaps there is an error number in your WindowsUpdate.log file that
could
> > help point in the right direction for a resolution.
> > Take note of the date and time just prior to accessing the Windows
Update
> > site. After connecting to the site, clicking on Express option, etc.,
close
> > Windows Update site. Now, navigate to the C:\Windows folder and open the
> > WindowsUpdate.log file (if there are 2 log files for Windows Update,
open
> > the one where WindowsUpdate is displayed as one word in the filename).
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Copy
> > the entries in that file that match the date and time for which you took
> > note (they will be at the bottom of the file). Paste these entries into
a
> > reply.
> >
> >
> >
> > Regards,
> >
> > −−
> > Patti MacLeod
> > Microsoft MVP − Windows Shell/User
> >
> > "jalbert" <jalbert@xxxxxxxxxxxxxxxxxxxxxxxxx> wrote in message
> > news:14CA02AB−8D6C−4E46−815B−1627409293B1@xxxxxxxxxxxxxxxx
> > > Patti − Thanks for the feedback. Still no joy. It looks as though
the
> > > ActiveX is being downloaded and registered, but then I'm back in the
same
> > old
> > > loop. I did check the WuWebControlClass and it is enabled. This is a
> > real
> > > stumper for me. Thanks again.
> > >
> > > Regards.
> > >
> > > "Patti MacLeod" wrote:
> > >
> > > > Windows Update uses an ActiveX control. Try changing the setting for
> > ActiveX
> > > > to "prompt" instead of "disable" and allow the ActiveX control for
> > Windows
> > > > Update to be d/loaded.
> > > >
> > > > If still no joy, and since you're running SP2, open IE and go to
> > > > Tools>Manage Add−Ons. In the "Show" window, select "Add−ons that
have
> > been
> > > > used by Internet Explorer" and ensure that WuWebControlClass is
enabled.
> > > >
> > > >
> > > >
> > > > Regards,
> > > >
> > > > −−
> > > > Patti MacLeod
> > > > Microsoft MVP − Windows Shell/User
> > > >
> > > > "jalbert" <jalbert@xxxxxxxxxxxxxxxxxxxxxxxxx> wrote in message
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> > > > news:9B4B2B7D−BA5C−4937−AC3F−EDBFF69C2943@xxxxxxxxxxxxxxxx
> > > > > Thanks Patti, unfortunately − no go. Starting and stopping the
> > windows
> > > > > update service was a new twist, I'm still getting the same
circular
> > > > results.
> > > > >
> > > > > All − There is an ActiveX control message that shows briefly (very
> > > > briefly)
> > > > > and I've set the automatic ActiveX control respone from "enabled"
to
> > > > > "disabled" as MS suggested. Anyone out there have any other
ideas?
> > > > Thanks
> > > > > for your thoughts and help.
> > > > >
> > > > >
> > > > >
> > > > > "Patti MacLeod" wrote:
> > > > >
> > > > > > Hi jalbert,
> > > > > >
> > > > > > Give this a try and see if it resolves the problem........
> > > > > >
> > > > > > Go to Start>Run and key in:
> > > > > > net.exe stop wuauserv
> > > > > > Click on OK or hit ENTER
> > > > > >
> > > > > > Go to Start>Run and key in:
> > > > > > regsvr32 wuapi.dll
> > > > > > Click on OK or hit ENTER
> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > regsvr32 wups.dll
> > > > > > Click on OK or hit ENTER
> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > regsvr32 wuaueng.dll
> > > > > > Click on OK or hit ENTER
> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > regsvr32 wuaueng1.dll
> > > > > > Click on OK or hit ENTER
> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > regsvr32 wucltui.dll
> > > > > > Click on OK or hit ENTER

Re: Windows Update after SP2 installation

Re: Windows Update after SP2 installation 7



> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > regsvr32 wuweb.dll
> > > > > > Click on OK or hit ENTER
> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > regsvr32 jscript.dll
> > > > > > Click on OK or hit ENTER
> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > regsvr32 atl.dll
> > > > > > Click on OK or hit ENTER
> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > regsvr32 softpub.dll
> > > > > > Click on OK or hit ENTER
> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > regsvr32 msxml3.dll
> > > > > > Click on OK or hit ENTER
> > > > > > Click on OK in the RegSvr32 dialogue box
> > > > > >
> > > > > > Start>Run and key in:
> > > > > > net.exe start wuauserv
> > > > > >
> > > > > > Now try the Windows Update site.
> > > > > >
> > > > > > Alternatively, you could create a command script file to run the
> > above
> > > > > > commands in a Command Prompt window......
> > > > > >
> > > > > > Go to Start>Run
> > > > > > Key in:
> > > > > > cmd
> > > > > > Click on OK or hit ENTER
> > > > > >
> > > > > > In the Command Prompt window, key in:
> > > > > > notepad registerit.cmd
> > > > > > Hit ENTER
> > > > > >
> > > > > > A Notepad window will open with a dialogue box asking if you
want to
> > > > create
> > > > > > a new file. Click on Yes in the dialogue box.
> > > > > >
> > > > > > Copy/paste the following, between but not including the
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asterisks,
> > into
> > > > the
> > > > > > Notepad window:
> > > > > >
> > > > > > *********************
> > > > > > net stop wuauserv
> > > > > >
> > > > > > regsvr32 /s wuapi.dll
> > > > > >
> > > > > > regsvr32 /s wups.dll
> > > > > >
> > > > > > regsvr32 /s wuaueng.dll
> > > > > >
> > > > > > regsvr32 /s wuaueng1.dll
> > > > > >
> > > > > > regsvr32 /s wucltui.dll
> > > > > >
> > > > > > regsvr32 /s wuweb.dll
> > > > > >
> > > > > > regsvr32 /s jscript.dll
> > > > > >
> > > > > > regsvr32 /s atl.dll
> > > > > >
> > > > > > regsvr32 /s softpub.dll
> > > > > >
> > > > > > regsvr32 /s msxml3.dll
> > > > > >
> > > > > > net start wuauserv
> > > > > > **********************
> > > > > >
> > > > > > When finished pasting the above commands into the Notepad
window, go
> > to
> > > > > > File>Save then File>Exit.
> > > > > >
> > > > > > Back in the Command Prompt window, key in:
> > > > > > registerit.cmd
> > > > > > Then hit ENTER
> > > > > >
> > > > > > When the file is done running, and you're back at the C: prompt,
key
> > in:
> > > > > > exit
> > > > > > Then hit ENTER
> > > > > >
> > > > > > Now try the Windows Update site.
> > > > > >
> > > > > >
> > > > > >
> > > > > > Regards,
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> > > > > >
> > > > > > −−
> > > > > > Patti MacLeod
> > > > > > Microsoft MVP − Windows Shell/User
> > > > > >
> > > > > > "jalbert" <jalbert@xxxxxxxxxxxxxxxxxxxxxxxxx> wrote in message
> > > > > > news:FEEE8838−EC2F−4E4D−8053−0108C4496F4C@xxxxxxxxxxxxxxxx
> > > > > > > I had a successful SP2 installation and am now trying to apply
any
> > > > > > subsequent
> > > > > > > updates. When I use the Windows Update site, I start by
asking
> > for
> > > > the
> > > > > > > Express option. I then get a screen that tells me "Files
required
> > to
> > > > use
> > > > > > > Windows Update are no longer registered or installed on your
> > computer.
> > > > To
> > > > > > > continue:" presents me with the option to "Register or
reinstall
> > the
> > > > files
> > > > > > > for me now (Recommended)". I register, it appears to
"register"
> > and
> > > > then
> > > > > > > takes me back to the Windows Update screen. If I try
"Express"
> > again
> > > > I go
> > > > > > > back to the "Files required" screen − basically an endless
loop
> > > > between
> > > > > > the
> > > > > > > two screens. Neither of the suggested fixes Microsoft had
> > available
> > > > > > apply −
> > > > > > > I see NO error message, just NO update action
> > > > > > >
> > > > > > >
> > > > > >
> > > > > >
> > > > > >
> > > >
> > > >
> > > >
> >
> >
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